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Introduction to KiCad Version 9
KiCad ist ein Open-Source-Softwarepaket zur Erstellung von elektronischen Schaltplänen, Leiterplatten
(PCBs) und zugehörigen Bauteilbeschreibungen. KiCad unterstützt einen integrierten Design-Workflow, bei
dem ein Schaltplan und die dazugehörige Leiterplatte zusammen entworfen werden, sowie eigenständige
Workflows für spezielle Anwendungen. KiCad enthält auch mehrere Dienstprogramme, die bei der

Schaltungs- und PCB-Konstruktion helfen, einschließlich eines PCB-Rechners zur Bestimmung der
elektrischen Eigenschaften von Schaltkreisstrukturen, eines Gerber-Viewers zur Inspektion von
Fertigungsdateien, eines 3D-Viewers zur Visualisierung der fertigen Leiterplatte und eines integrierten
SPICE-Simulators zur Überprüfung des Schaltungsverhaltens.

KiCad läuft auf allen gängigen Betriebssystemen und einer breiten Palette von Computerhardware. Es
unterstützt Leiterplatten mit bis zu 32 Kupferebenen und eignet sich für die Erstellung von Designs aller
Komplexitätsgrade. KiCad wird von einem freiwilligen Team von Software- und Elektroingenieuren auf der

ganzen Welt entwickelt, die es sich zur Aufgabe gemacht haben, freie und quelloffene
Elektronikdesignsoftware für professionelle Designer zu erstellen.

The latest documentation for KiCad is available at https://docs.kicad.org. This document applies to KiCad
version 9.0.

Herunterladen und Installieren von KiCad
KiCad läuft auf vielen Betriebssystemen, einschließlich Microsoft Windows, Apple macOS und vielen
gängigen Linux-Distributionen.

Die aktuellsten Anleitungen und Download-Links finden Sie unter https://www.kicad.org/download/. Diese
Anleitungen sind nicht in diesem Handbuch enthalten, da sie sich im Laufe der Zeit durch die

Veröffentlichung von Betriebssystem-Updates ändern können.

IMPORTANT

KiCad Stable Releases werden in regelmäßigen Abständen gemäß der KiCad Stable
Release Policy veröffentlicht. Dem Entwicklungszweig werden fortwährend neue
Funktionen hinzugefügt. Wenn Sie die Vorteile dieser neuen Funktionen nutzen und
beim Testen helfen möchten, laden Sie bitte das neueste Nightly-Build-Paket für Ihre
Plattform herunter. Nightly Builds können Fehler wie z. B. Dateifehler, die Erzeugung
von schlechten Gerbern usw. enthalten, jedoch ist es das Ziel des KiCad-
Entwicklungsteams, den Entwicklungszweig während der Entwicklung neuer
Funktionen so benutzbar wie möglich zu halten.

Unterstützung
Wenn Sie Ideen, Anmerkungen oder Fragen haben, oder einfach nur Hilfe benötigen:

Das offizielles KiCad-Benutzerforum ist ein hervorragender Ort, um mit anderen KiCad-Benutzern in
Kontakt zu treten und Hilfe zu erhalten.

Treten Sie unseren Communities auf Discord oder IRC bei, um in Echtzeit mit Benutzern und Entwicklern
zu diskutieren.

Auf der KiCad-Website finden Sie Lernressourcen, die von der KiCad- Community erstellt wurden.

https://docs.kicad.org/
https://www.kicad.org/download/
https://dev-docs.kicad.org/en/rules-guidelines/release-policy/
https://forum.kicad.info/
https://www.kicad.org/community/chat/
https://www.kicad.org/help/learning-resources/
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Grundlegende Konzepte und Arbeitsweise
Der typische Arbeitsablauf in KiCad besteht aus zwei Hauptaufgaben: dem Zeichnen eines Schaltplans und
dem Layouten einer Leiterplatte.

Der Schaltplan ist eine symbolische Darstellung der Schaltung: welche Komponenten verwendet werden und
welche Verbindungen zwischen ihnen bestehen. Schaltplansymbole sind bildliche Darstellungen

elektronischer Komponenten in einem Schaltplan, z. B. ein Zickzack oder Rechteck für einen Widerstand
oder ein Dreieck für einen Operationsverstärker. Der Schaltplan enthält Symbole für jedes Bauteil und
Verbindungen zwischen den Pins in den Symbolen. In der Regel wird der Schaltplan zuerst gezeichnet, bevor
die Leiterplatte ausgelegt wird.
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Die Platine ist die physische Umsetzung des Schaltplans, wobei die Footprints der Komponenten auf der
Platine positioniert sind und die Kupferbahnen die im Schaltplan beschriebenen Verbindungen herstellen.

Footprints sind eine Anordnung von Kupferpads, die mit den Pins eines physischen Bauteils
übereinstimmen. Bei der Herstellung und Bestückung der Leiterplatte wird das Bauteil auf den
entsprechenden Footprint der Leiterplatte gelötet.

KiCad verfügt über separate Fenster zum Zeichnen des Schaltplans ("Schaltplaneditor"), zum Layouten der
Leiterplatte ("Leiterplatteneditor") und zum Bearbeiten von Symbolen und Footprints ("Symboleditor" und
"Footprinteditor"). KiCad wird mit einer großen Bibliothek von qualitativ hochwertigen, von Benutzern

beigetragenen Symbolen und Footprints geliefert, aber es ist auch einfach, neue Symbole und Footprints zu
erstellen oder bestehende Symbole und Footprints zu ändern.
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Abschließend soll betont werden, dass KiCad einen projektbasierten Arbeitsablauf hat. Ein KiCad-Projekt ist
ein Ordner mit einer Projektdatei, einem Schaltplan, einem Platinenlayout und anderen optionalen Dateien
wie Symbol- und Footprint-Bibliotheken, Simulationsdaten, Einkaufsinformationen usw. Viele
projektbezogene Einstellungen, einschließlich Netzklassen und Designregeln, werden auf Projektebene

gespeichert. Wenn Sie eine Platine außerhalb des zugehörigen Projekts öffnen, kann dies zu fehlenden
Designinformationen führen. Achten Sie daher darauf, dass Sie alle zu einem Projekt gehörenden Dateien
zusammen verwalten.

Vorgehen für den Leiterplattenentwurf
Üblicherweise wird zuerst der Schaltplan gezeichnet. Dies bedeutet, dass dem Schaltplan Symbole

hinzugefügt und die Verbindungen zwischen ihnen gezeichnet werden. Unter Umständen müssen
benutzerdefinierte Symbole erstellt werden, wenn die entsprechenden Symbole nicht bereits vorhanden
sind. In dieser Phase werden auch die Footprints für jede Komponente ausgewählt und bei Bedarf
benutzerdefinierte Footprints erstellt. Wenn der Schaltplan vollständig ist und das Design eine elektrische

Regelprüfung (ERC) bestanden hat, werden die Designinformationen im Schaltplan in den
Leiterplatteneditor übertragen und das Layout beginnt.

The schematic describes which components are in the design and how they are connected; the board editor
uses this information to make layout easier and to prevent mismatches between the schematic and PCB. The

layout process requires careful placement of each footprint on the circuit board. After component
placement, copper tracks are drawn between components based on the connections in the schematic as well
as other electrical considerations, such as track resistance, controlled impedance requirements, crosstalk,

etc.

Oft muss der Schaltplan aktualisiert werden, nachdem mit dem Layout begonnen wurde. Die Änderungen
am Schaltplan können dann einfach in das Leiterplattendesign übernommen werden. Der umgekehrte Fall
tritt häufig ein: Designänderungen, die im Leiterplattenlayout vorgenommen werden, können in den

Schaltplan übernommen werden, um die Konsistenz zwischen den beiden zu gewährleisten.

Wenn das Platinenlayout vollständig ist und die Platine den Designregel-Check (DRC) bestanden hat, werden
Fertigungsausgaben generiert, so dass die Platine von einem Leiterplattenhersteller gefertigt werden kann.
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Tutorial Teil 1: Projekt
Wenn Sie einen neuen Entwurf beginnen, müssen Sie zunächst ein neues Projekt erstellen. Wenn Sie KiCad
öffnen, wird die Projektverwaltung angezeigt. Klicken Sie auf Datei → Neues Projekt, suchen Sie den
gewünschten Speicherort und geben Sie Ihrem Projekt einen Namen, z. B. Erstes_Projekt . Vergewissern
Sie sich, dass das Kontrollkästchen Ein neues Verzeichnis für das Projekt erstellen aktiviert ist, und

klicken Sie dann auf Speichern. Dadurch werden Ihre Projektdateien in einem neuen Unterordner mit
demselben Namen wie Ihr Projekt angelegt.

Auf der linken Seite sind im Bereich Projektdateien  die Dateien des neuen Projekts aufgelistet. Es gibt eine
Projektdatei mit der Erweiterung .kicad_pro , eine Schaltplandatei mit der Erweiterung .kicad_sch  und
eine Platinen-Datei mit der Erweiterung .kicad_pcb . Diese Dateien haben alle den gleichen Namen wie Ihr

Projekt.

Es kann auch ein Verzeichnis -backups  geben: KiCad erstellt automatisch Sicherungskopien Ihres Projekts,
wenn Sie speichern, und optional in festen Zeitabständen. Die Backup-Einstellungen sind konfigurierbar
unter Einstellungen → Einstellungen → Allgemein → Projekt- Sicherungskopien.

NOTE Das Öffnen des Einstellungsdialogs kann einen Dialog zur Konfiguration der
Bibliothekstabelle auslösen. Dieser Dialog wird unten erklärt.

NOTE On macOS, the Preferences dialog is in the KiCad menu, not the Preferences menu.
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Auf der rechten Seite des Projektfensters befinden sich Schaltflächen zum Starten der verschiedenen
Werkzeuge, die KiCad bietet. Beim Starten dieser Werkzeuge wird automatisch die zugehörige
Entwurfsdatei (Schaltplan oder PCB) aus dem aktuellen Projekt geöffnet. Beginnen Sie mit dem Öffnen des
Schaltplaneditors.
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Tutorial Part 2: Schaltplan
Einrichtung der Symbolbibliothekstabelle
Wenn der Schaltplaneditor zum ersten Mal geöffnet wird, erscheint ein Dialog, in dem Sie gefragt werden,
wie Sie die globale Symbolbibliothekstabelle konfigurieren möchten. Die Symbolbibliothekstabelle teilt
KiCad mit, welche Symbolbibliotheken verwendet werden sollen und wo sie sich befinden. Wenn Sie die
Standardbibliotheken mit KiCad installiert haben, was empfohlen wird, wählen Sie die Standardoption:

Globale Standard-%s-Bibliothekstabelle kopieren.

Wenn KiCad die Bibliotheken nicht an ihrem erwarteten Installationsort finden kann, wird diese Option
deaktiviert. In diesem Fall sollten Sie die zweite Option Benutzerspezifische globale Symbol-
Bibliothekstabelle kopieren wählen. Klicken Sie auf die Ordner-Schaltfläche am unteren Rand und

navigieren Sie zum unten angegebenen Speicherort. Wählen Sie die Datei sym-lib-table .

Der Speicherort der Standardbibliothekstabellendateien ist betriebssystemabhängig und kann je nach
Installationsort variieren. Nachfolgend sind die Standardwerte für jedes Betriebssystem aufgeführt:

Windows: C:\Program Files\KiCad\9.0\share\kicad\template\

Linux: /usr/share/kicad/template/

macOS: /Applications/KiCad/KiCad.app/Contents/SharedSupport/template/

Schaltplaneditor Grundlagen
Um den Schaltplan zu verschieben, klicken und ziehen Sie mit der mittleren oder rechten Maustaste.
Vergrößern und verkleinern Sie die Ansicht mit dem Mausrad oder mit  und . Für Laptop-Benutzer
kann es nützlich sein, die Maussteuerung so zu ändern, dass sie besser für ein Touchpad geeignet ist. Die
Maussteuerung kann unter Einstellungen → Einstellungen…  → Maus und Touchpad konfiguriert werden.

F1 F2
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NOTE On macOS, the Preferences dialog is in the KiCad menu, not the Preferences menu.

KiCad aktiviert standardmäßig die Mauseinstellung Cursor beim Zoomen zentrieren und positionieren.
Wenn diese Funktion aktiviert ist, wird der Mauszeiger automatisch in die Mitte des Bildschirms bewegt,
wenn man hinein- oder herauszoomt. Dadurch bleibt der gezoomte Bereich immer zentriert. Diese Funktion
ist ungewöhnlich, aber viele Benutzer finden sie nützlich, sobald sie sich daran gewöhnt haben. Versuchen

Sie, mit dem Mauszeiger in verschiedene Bereiche der Arbeitsfläche hinein- und herauszuzoomen. Wenn Sie
das Standard-Zoomverhalten als unangenehm empfinden, deaktivieren Sie die Funktion in den
Voreinstellungen für Maus und Touchpad.

Die Symbolleiste auf der linken Seite des Schaltplaneditors enthält die wesentlichen Anzeigeeinstellungen.
Die Symbolleiste auf der rechten Seite des Bildschirms enthält Werkzeuge zur Bearbeitung des Schaltplans.

Most tools in KiCad either have default hotkeys assigned, or can have custom hotkeys assigned. To view all
hotkeys, go to Help → List Hotkeys… . Hotkeys can be changed in the Hotkeys panel of the Preferences

dialog.

Einrichtung des Schaltplanblatts
Bevor Sie etwas in den Schaltplan zeichnen, richten Sie das Schaltplanblatt selbst ein. Klicken Sie auf Datei
→ Seite einrichten… . Geben Sie dem Schaltplan einen Titel und ein Datum, und ändern Sie gegebenenfalls
das Papierformat.
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Symbole in den Schaltplan einfügen
Beginnen Sie mit der Erstellung der Schaltung, indem Sie dem Schaltplan einige Symbole hinzufügen. Öffnen

Sie das Dialogfeld Symbol auswählen, indem Sie auf die Schaltfläche Symbol hinzufügen  auf der

rechten Seite des Fensters klicken oder  drücken.

Diese Aktion löst den Einstellungsdialog der Footprintbibliothekstabelle aus, wenn er nicht bereits ausgelöst
wurde. Dieser Dialog entspricht dem bereits erläuterten Dialog Einrichtung der Symbolbibliothekstabelle,
jedoch für Footprints anstelle von Symbolen.

Wählen Sie auch hier die Standardoption: Globale Standard-Footprint-Bibliothekstabelle kopieren
(empfohlen). Wenn diese Option deaktiviert ist, wählen Sie die zweite Option: Benutzerspezifische
globale Footprint-Bibliothekstabelle kopieren. Klicken Sie unten auf die Schaltfläche Ordner  und
wechseln Sie zu dem Ort gemäß der Anleitung zur Einrichtung der Symbolbibliothekstabelle. Wählen Sie die

Datei fp-lib-table  und klicken Sie auf OK.

Der Dialog Symbol wählen  listet die verfügbaren Symbolbibliotheken und die darin enthaltenen
Bauteilsymbole auf. Grundlegende Bauteile wie passive Komponenten, Dioden und andere allgemeine
Symbole befinden sich in der Bibliothek Device . Spezielle Bauteile, wie z. B. eine bestimmte LED, können in

anderen Bibliotheken enthalten sein.

Scrollen Sie nach unten zur Bibliothek Device , klappen Sie sie auf, und wählen Sie das Symbol LED  aus.
Klicken Sie auf OK, und klicken Sie erneut, um das Symbol im Schaltplan zu platzieren.

A
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Als nächstes fügen Sie einen strombegrenzenden Widerstand hinzu. Gehen Sie zurück zur Schaltplansymbol-
Auswahl, aber versuchen Sie diesmal, nach einem Widerstand zu suchen, indem Sie R  oben in das Filterfeld

eingeben. Auch hier wird er in der Bibliothek Device  gefunden. Das R -Element ist ein rechteckiges
Widerstandssymbol im IEC-Stil. Für Benutzer, die das Zickzack-Symbol im ANSI-Stil bevorzugen, ist auch ein
R_US -Symbol verfügbar. Wählen Sie ein Widerstandssymbol aus und fügen Sie es dem Schaltplan hinzu.

Zum Schluss fügen Sie eine Batterie zur Stromversorgung der LED hinzu. Die Bibliothek Device  hat ein
passendes Symbol Battery_Cell .
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Auswählen und Verschieben von Objekten
Next, position the symbols correctly relative to each other, as shown in the screenshot. You will do this by
selecting each symbol, then moving and rotating it.

In KiCad, objects are selected by clicking on them while the selection tool is active. The selection tool is the
default tool when no other tool is active, so you can enter the selection tool by quitting any active tool (

) or by clicking the  button in the right toolbar.

Additional objects can be added to the selection with +click, or removed with + +click
(macOS: + +click). You can toggle an item’s selection state with +click (macOS: +click).

Ziehen von links nach rechts wählt Objekte aus, die vollständig vom Auswahlrahmen umschlossen sind,
während Ziehen von rechts nach links auch Objekte auswählt, die nur teilweise vom Auswahlrahmen erfasst

sind. , +  ( + ) und  ( ) können auch zusammen mit der
Ziehauswahl verwendet werden, um der Auswahl etwas hinzuzufügen, etwas abzuziehen oder sie zu
verändern.

Beachten Sie, dass es möglich ist, ein ganzes Symbol auszuwählen (durch Klicken auf die Symbolform selbst)

oder ein Textfeld im Symbol auszuwählen, ohne den Rest des Symbols auszuwählen (durch Klicken auf den
Text). Wenn nur ein Textfeld ausgewählt ist, wirken sich alle Aktionen nur auf den ausgewählten Text und
nicht auf den Rest des Symbols aus.

Ausgewählte Objekte werden durch Drücken von  verschoben und durch Drücken von  gedreht. Die
Taste  (Ziehen) kann auch zum Verschieben von Objekten verwendet werden. Für das Verschieben von
unverbundenen Symbolen verhalten sich  und  identisch, aber für Symbole mit anliegenden

Esc

Shift Ctrl Shift

Cmd Shift Ctrl Cmd

Umschalt Strg Umschalt Cmd Umschalt Strg Cmd

M R

G

G M



13

Verbindungen verschiebt  das Symbol und behält die Verbindungen bei, während  das Symbol
verschiebt und die Verbindungen zurücklässt. Ausgewählte Objekte können mit der Taste  gelöscht

werden.

Verdrahtung des Schaltplans
The symbol pins all have small circles on them, indicating that they are not connected. Fix that by drawing

wires between symbol pins as shown in the screenshot. Click the Add a Wire button  on the right-hand

toolbar or use the  hotkey. Click and release to start drawing a wire, and finish drawing the wire by
clicking on a symbol pin or double clicking anywhere. Pressing Escape will cancel drawing the wire.

Eine weitere bequeme Methode zum Zeichnen von Verbindungen besteht darin, den Mauszeiger über einen
nicht angeschlossenen Pin zu bewegen. Der Mauszeiger ändert sich und zeigt an, dass von dieser Stelle aus
eine Verbindung gezeichnet werden kann. Wenn Sie auf den Pin klicken, wird automatisch eine Verbindung
gezeichnet.

Als Nächstes fügen Sie dem Schaltplan Stromversorgungs- und Erdungssymbole hinzu. Diese Symbole sind
bei einem so einfachen Schaltplan zwar nicht unbedingt erforderlich, erleichtern aber das Verständnis
großer Schaltpläne.

Eine Reihe von Spannungs- und Erdungssymbolen sind in der Symbolbibliothek power  verfügbar. Es gibt

jedoch eine Abkürzung für das Hinzufügen dieser Symbole: Klicken Sie auf die Schaltfläche
Spannungsquelle hinzufügen  oder verwenden Sie die Taste . Dies öffnet das Dialogfeld Symbol

wählen, zeigt aber nur Symbolbibliotheken an, die Spannungssymbole enthalten.

G M

Entf

W
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Fügen Sie je ein Symbol für VCC und für GND hinzu und stellen Sie dann mit der Schaltung eine elektrische
Verbindung her.

Beschriften Sie schließlich die Leitung zwischen der LED und dem Widerstand. Auch dies ist bei einer
einfachen Schaltung vielleicht nicht notwendig, aber es ist eine gute Übung, wichtige Netze zu beschriften.

Klicken Sie auf die Schaltfläche Bezeichner hinzufügen  in der rechten Symbolleiste ( ), geben Sie

einen Beschriftungsnamen ein ( led ) und platzieren Sie die Beschriftung so im Schaltplan, dass sich der
quadratische Befestigungspunkt mit dem Draht überlappt. Drehen Sie das Etikett nach Bedarf und richten

Sie es aus.

Beachten Sie, dass Beschriftungen und Spannungssymbole mit demselben Namen miteinander verbunden
sind. Ein weiteres GND-Symbol oder eine Verbindung mit der Bezeichnung „led“ auf dieser Schaltplanseite
würde mit dem vorhandenen kurzgeschlossen, auch wenn sie nicht optisch verbunden sind.

Beschriftung, Symboleigenschaften und Footprints

L
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Beschriftung
Jedem Symbol muss ein eindeutiger Referenzbezeichner zugewiesen werden. Dieser Vorgang wird auch als
Annotation bezeichnet.

By default, symbols are automatically annotated when they are added to the schematic. Automatic

annotation can be enabled or disabled using the  button in the left toolbar.

Auch wenn es für diesen Leitfaden nicht notwendig ist, können Symbole mit Hilfe der Schaltfläche

Schaltplan annotieren…  ( ) in der oberen Symbolleiste manuell bezeichnet oder neu bezeichnet

werden.

Symboleigenschaften
Geben Sie nun die Werte für die einzelnen Komponenten ein. Wählen Sie die LED aus, klicken Sie mit der
rechten Maustaste, und wählen Sie Eigenschaften…  ( ). In diesem Projekt wird eine rote LED verwendet,
also ändern Sie das Feld Value  in Rot . In einem echten Projekt wäre es vielleicht besser, hier stattdessen

die Teilenummer des LED-Herstellers einzutragen. Beachten Sie, dass es möglich ist, Referenzbezeichner in
den Eigenschaften jedes Symbols individuell zu bearbeiten.

In diesem Projekt wird eine 3V-Lithium-Knopfzelle verwendet, also ändern Sie das Feld Value  von BT1  in
3V . Ändern Sie den Wert des Widerstands auf „1k“.

Footprint Zuordnung
Schließlich weisen Sie jeder Komponente einen Footprint zu. Damit wird festgelegt, wie jedes Bauteil auf der
Leiterplatte platziert werden soll. Einigen Symbolen sind bereits Footprints zugewiesen, aber für viele
Komponenten gibt es mehrere mögliche Footprints, so dass man den passenden auswählen muss.

Es gibt mehrere Möglichkeiten, Footprints zuzuweisen, aber eine einfache Möglichkeit ist die Verwendung

des Footprint-Zuordnungswerkzeugs durch Klicken auf die Schaltfläche Footprints zuweisen…  in der

oberen Symbolleiste.

Im linken Bereich dieses Fensters sind die verfügbaren Footprint-Bibliotheken aufgelistet. Der mittlere
Bereich zeigt die Symbole im Schaltplan. All diesen Symbolen werden Footprints zugewiesen. Das rechte
Fenster zeigt die Footprints an, die für das im mittleren Bereich ausgewählte Symbol gewählt werden

können. Um einem Symbol einen Footprint zuzuweisen, wählen Sie das Symbol im mittleren Bereich aus und
doppelklicken Sie auf den gewünschten Footprint im rechten Bereich. Sie können eine Vorschau eines
Footprints anzeigen, indem Sie mit der rechten Maustaste auf den Namen des Footprints klicken und
Ausgewählten Footprint anzeigen wählen.

E
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KiCad enthält viele Footprints, daher bietet das Footprint-Zuordnungswerkzeug mehrere Möglichkeiten,
Footprints herauszufiltern, die für das betreffende Symbol nicht relevant sind.

Die Schaltfläche ganz links  aktiviert die Filter, die im jeweiligen Symbol definiert werden können.

Für ein Operationsverstärkersymbol können beispielsweise Filter definiert werden, die nur SOIC- und

DIP-Footprints anzeigen. Manchmal sind diese vordefinierten Filter nicht vorhanden oder zu restriktiv,
so dass es in manchen Situationen sinnvoll sein kann, diesen Filter auszuschalten.

Die mittlere Schaltfläche  filtert nach der Anzahl der Pins, so dass nur 8-Pad-Footprints für 8-Pin-

Symbole angezeigt werden. Dieser Filter ist fast immer nützlich.

Die rechte Schaltfläche  filtert nach der ausgewählten Bibliothek. Bibliotheken werden im linken

Fenster ausgewählt. Footprints, die nicht in der ausgewählten Bibliothek enthalten sind, werden
herausgefiltert. Dieser Filter ist nützlich, solange bekannt ist, welche Bibliothek den richtigen Footprint
enthält. Oft ist es am besten, diesen Filter oder die Symbolfilter zu verwenden, aber nicht beide.

Das Textfeld filtert Footprints heraus, die nicht mit dem Text im Feld übereinstimmen. Dieser Filter ist
deaktiviert, wenn das Feld leer ist.

Using the filters, find each of the footprints shown in the central column in the screenshot above. The
footprints for each symbol are also listed in the table below. Assign each footprint to a symbol by selecting

the symbol in the central column and then double clicking the appropriate footprint in the right column.
Once all of the footprints have been assigned, click OK.

Symbol Reference Footprint to assign

BT1 Battery:BatteryHolder_Keystone_1058_1x2032

D1 LED_THT:LED_D5.0mm

R1 Resistor_THT:R_Axial_DIN0309_L9.0mm_D3.2mm_P12.70mm_Horizontal

Es gibt auch andere Möglichkeiten, Footprints zuzuweisen. Eine davon ist das Fenster mit den
Symboleigenschaften. Weitere Informationen zur Zuweisung von Footprints finden sie im Handbuch.

file:///src/build/src/getting_started_in_kicad/eeschema/eeschema.html#assigning-footprints
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Elektrische Regeln überprüfen
Das letzte, was im Schaltplan noch zu tun ist, ist die Überprüfung auf elektrische Fehler. Der Electrical Rules
Checker (ERC) von KiCad kann nicht sicherstellen, dass der Entwurf im Schaltplan funktioniert, aber er kann

auf einige häufige Verbindungsprobleme prüfen, wie z. B. nicht angeschlossene Pins, zwei kurzgeschlossene
Stromausgänge oder ein Stromeingang, der nicht mit Strom versorgt wird. Es wird auch auf einige andere
Fehler wie nicht beschriftete Symbole und Tippfehler in Netzbeschriftungen geprüft. Um die vollständige
Liste der elektrischen Regeln zu sehen und ihren Schweregrad einzustellen, gehen Sie zu Datei →

Schaltplan einrichten…  → Elektrische Regeln → Verstoß-Schweregrade. Es ist ratsam, den ERC
auszuführen, bevor Sie mit dem Layout beginnen.

Führen Sie eine elektrische Regelprüfung durch, indem Sie auf die Schaltfläche ERC ( ) in der oberen

Symbolleiste und dann auf ERC starten klicken.

Selbst in diesem einfachen Schaltplan hat KiCad zwei potenzielle Fehler gefunden. Die Fehler sind im ERC-

Fenster aufgelistet, und Pfeile zeigen auf die kritischen Stellen im Schaltplan. Wenn Sie eine Verletzung im
ERC-Fenster auswählen, wird der entsprechende Pfeil hervorgehoben.

Sie können einzelne Verstöße ausschließen oder ganze Klassen von Verstößen ignorieren, indem Sie mit der
rechten Maustaste auf jede Fehlermeldung klicken. Auch wenn es sich nicht um tatsächliche Entwurfsfehler
handelt, lohnt es sich in der Regel dennoch, sich mit den Verstößen zu befassen, um einen sauberen ERC-

Bericht zu erhalten und zu vermeiden, dass echte Probleme übersehen werden.

In diesem Fall meldet KiCad „Input-Power-Pin wird von keinem Output-Power-Pin angesteuert“ für die
beiden Netze „VCC“ und „GND“. Dies ist ein häufiger KiCad ERC-Fehler. Stromversorgungssymbole sind so
eingestellt, dass ein Stromversorgungsausgangspin, wie z.B. der Ausgang eines Spannungsreglers, auf



18

demselben Netz benötigt wird; andernfalls denkt KiCad, dass das Netz nicht angesteuert ist. Für einen
Menschen ist es offensichtlich, dass VCC  und GND  von der Batterie gespeist werden, aber es ist notwendig,

dies explizit im Schaltplan zu zeigen.

Es gibt ein spezielles PWR_FLAG -Symbol in der Power -Symbolbibliothek, das dieses Problem löst, indem es
KiCad mitteilt, dass die Netze tatsächlich angesteuert werden. Fügen Sie dieses Symbol zu den VCC - und
GND -Netzen hinzu und führen Sie ERC erneut aus. Wenn ERC ohne Verstöße durchläuft, ist der Schaltplan
vollständig.

Stückliste
Ein letzter optionaler Schritt besteht darin, eine Materialliste zu erstellen, in der alle im Projekt
verwendeten Komponenten aufgeführt sind. Klicken Sie auf Werkzeuge → Stückliste (BoM) erstellen… .
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KiCad has a GUI for BOM export. You can configure which symbol metadata will be exported, and how the
symbols are grouped, in the Edit tab, and configure the output format in the Export tab.

Für diesen Moment sollten die Standardeinstellungen ausreichen, aber Sie können eine Rohansicht dessen,

was exportiert wird, im Vorschaufenster sehen. Geben Sie auf der Registerkarte Exportieren eine
Ausgabedatei an und klicken Sie dann auf die Schaltfläche Exportieren.

Die Stückliste sollte wie im folgenden Bild aussehen, wenn sie in einem Tabellenkalkulationsprogramm
geöffnet wird.
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Tutorial Teil 3: Leiterplatte
Wenn der Schaltplan fertig ist, kehren Sie zum Projektfenster zurück und öffnen den Leiterplatteneditor,
indem Sie entweder auf die Schaltfläche Leiterplatteneditor klicken oder die Leiterplattendatei öffnen.

Leiterplatteneditor Grundlagen
Die Navigation im Leiterplatteneditor ist dieselbe wie im Schaltplaneditor: den Fensterinhalt verschieben
durch Ziehen mit der mittleren oder rechten Maustaste und Zoomen mit dem Scrollrad oder / .

Der Hauptbereich des Leiterplatteneditors ist eine Zeichenfläche, auf der die Leiterplatte entworfen wird.
Die Symbolleiste auf der linken Seite enthält verschiedene Anzeigeoptionen für die Leiterplatte,
einschließlich Einheiten und Umschaltmöglichkeiten für die Darstellung von Leiterbahnen,
Durchkontaktierungen, Pads und Zonen als Umriss oder ausgefüllt. Die Symbolleiste rechts neben der

Leinwand enthält Werkzeuge für das Design der Leiterplatte.

NOTE

Einige Schaltflächen in der rechten Symbolleiste haben ein kleines Dreieck in der unteren

rechten Ecke . Das Dreieck zeigt an, dass die Schaltfläche über eine sich erweiternde

Palette verfügt, die mehrere verwandte Werkzeuge enthält, zum Beispiel verschiedene
Arten von Bemaßungen. Zur Auswahl klicken Sie auf die Schaltfläche und halten Sie sie
gedrückt, bis die Palette erscheint, und klicken Sie dann auf das alternative Werkzeug.
Alternativ klicken Sie auf die Schaltfläche und ziehen Sie sie nach links, bis die Palette
erscheint. Lassen Sie die Maustaste los, wenn das gewünschte Werkzeug markiert ist.

Ganz rechts befinden sich das Darstellungs-Panel und der Auswahlfilter. Das Darstellungs-Panel wird

verwendet, um die Sichtbarkeit, die Farben und die Deckkraft von Leiterplattenebenen, Objekten und
Netzen zu ändern. Die aktive Ebene wird durch Klicken auf den Namen einer Ebene geändert.

Unterhalb des Darstellungs-Panels befindet sich der Auswahlfilter, der die Auswahl verschiedener Arten von

Leiterplattenobjekten ein- und ausschaltet. Dies ist nützlich, um bestimmte Objekte in einem beengten
Layout auszuwählen.

Einrichtung und Lagenaufbau der Platine
Legen Sie vor dem Entwurf der Platine das Seitenformat fest und fügen Sie Informationen zum Schriftfeld
hinzu. Klicken Sie auf Datei → Seite einrichten… , wählen Sie dann ein geeignetes Papierformat aus und

geben Sie ein Datum, eine Revision und einen Titel ein.

F1 F2
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Als nächstes gehen Sie zu Datei → Platinenkonfiguration… , um festzulegen, wie die Leiterplatte

hergestellt werden soll. Die wichtigsten Einstellungen sind der Lagenaufbau, d. h. welche Kupfer- und
dielektrischen Lagen die Leiterplatte haben soll bzw. wie dick sie sein sollen, und die Designregeln, z. B. die
Größen und Abstände für Leiterbahnen und Durchkontaktierungen.

Um den Lagenaufbau einzustellen, wählen Sie im Fenster der Platinenkonfiguration Lagenaufbau der
Platine → Technischer Lagenaufbau. Für diesen Leitfaden belassen Sie die Anzahl der Kupferlagen bei 2,
aber für aufwändigere Projekte sind möglicherweise mehr Lagen erforderlich.
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Wählen Sie dann Designregeln → Einschränkungen. Die Einstellungen auf dieser Seite legen die
übergeordneten Designregeln für alle Elemente des Leiterplattenentwurfs fest. Für die Zwecke dieser

Anleitung sind die Standardeinstellungen ausreichend. Für ein reales Projekt sollten diese jedoch
entsprechend den Möglichkeiten der Leiterplattenfertigung eingestellt werden, damit der
Leiterplattenentwurf herstellbar ist.
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Finally, open the Design Rules → Net Classes page. A net class is a set of design rules associated with a
specific group of nets. This page lists the design rules for each net class in the design and allows assigning

nets to each net class (nets can also be assigned to net classes in the schematic editor).

Leiterbahnbreite und -abstände können vom Designer während des Layouts manuell verwaltet werden,
dennoch werden Netzklassen empfohlen, da sie eine automatische Möglichkeit zur Verwaltung und
Überprüfung von Designregeln bieten.

In this design, no net classes are specified, so all nets will belong to the Default  net class. The default design
rules for this net class are acceptable for this project, but other designs may have multiple net classes, each
with different design rules. For example a board might have a High Current  netclass with wide tracks, or a

50 ohm  netclass with specific width and clearance rules for 50 ohm controlled-impedance tracks.

Änderungen aus dem Schaltplan importieren
Der Schaltplan ist vollständig, aber es sind noch keine Komponenten im Layout vorhanden. Um Designdaten
aus dem Schaltplan in das Layout zu importieren, klicken Sie auf Werkzeuge → Platine aus Schaltplan
aktualisieren… , oder drücken Sie . Es gibt auch eine Schaltfläche  in der oberen Werkzeugleiste.

Lesen Sie sich die Meldungen im Fenster Ausstehende Änderungen durch, die besagen, dass die drei

Komponenten im Schaltplan zur Leiterplatte hinzugefügt werden. Klicken Sie auf Platine aktualisieren,
Schließen, und klicken Sie auf die Zeichenfläche, um die drei Footprints zu platzieren. Die Position der
einzelnen Footprints zueinander wird später noch geändert.

F8



24



25

In KiCad ist das Aktualisieren der Leiterplatte mit Änderungen im Schaltplan ein manueller Prozess: Der
Designer entscheidet, wann es angebracht ist, die Leiterplatte mit Änderungen im Schaltplan zu
aktualisieren. Jedes Mal, wenn der Schaltplan bearbeitet wird, muss der Konstrukteur das Werkzeug Platine
aus Schaltplan aktualisieren verwenden, um den Schaltplan und das Layout auf demselben Stand zu
halten.

Zeichnen eines Platinenumrisses
Nun sind die drei Komponenten platziert, aber die Platine selbst ist noch nicht definiert. Diese wird
definiert, indem ein Umriss der Platine auf der Ebene Edge.Cuts  gezeichnet wird.

Es ist oft nützlich, den Umriss der Platte mit einem groben Raster zu zeichnen, da man so einfach glatte
Zahlen für die Platinengröße erhält. Ändern Sie das Raster, indem Sie oberhalb der Zeichenfläche im
Dropdown-Menü ein Raster von 1 mm auswählen.

To draw on the Edge.Cuts  layer, click Edge.Cuts in the Layers tab of the Appearance panel at right. Choose

the rectangle tool  in the right toolbar, click on the canvas to place the first corner, then click again to

place the opposite corner so that the rectangle roughly surrounds the three footprints. The other graphic

tools (line , arc , circle , polygon , bezier , or a combination of them) could also be used to
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define the board outline; the only requirement is that the outline is a single closed shape that doesn’t
intersect itself.

Footprints positionieren
Der nächste Schritt im Layoutprozess ist die Anordnung der Footprints auf der Platine. Bei der

Positionierung der Footprints sind im Allgemeinen mehrere Aspekte zu berücksichtigen:

Für einige Footprints gibt es genaue Anforderungen an die Positionierung, z. B. für Anschlüsse, Anzeigen
oder Tasten und Schalter.

Einige Komponenten müssen unter Umständen nach elektrischen Gesichtspunkten platziert werden.
Bypass-Kondensatoren sollten sich in der Nähe der Stromversorgungspins des zugehörigen ICs befinden,
und empfindliche analoge Komponenten sollten weit von digitalen Störungen entfernt sein.

Almost all components have a "Courtyard" (or two if both Front and Back are defined). Generally
courtyards should not intersect.

Ansonsten sollten die Komponenten so positioniert werden, dass sie leicht zu routen sind. Verbundene
Komponenten sollten im Allgemeinen nahe beieinander liegen und so angeordnet sein, dass die

Komplexität des Routings minimiert wird. Die dünnen Verbindungslinien zwischen Pads, oft als
'Rattennest' bezeichnet, sind nützlich, um zu bestimmen, wie Footprints relativ zu anderen Footprints
am besten positioniert werden.

Im Sinne dieses Leitfadens besteht das einzige Ziel der Platzierung darin, den Routing-Prozess so einfach
wie möglich zu gestalten.

Beginnen Sie damit, den Batteriehalter BT1  auf die Rückseite der Platine zu verschieben. Klicken Sie ihn an,
um ihn auszuwählen, und drücken Sie , um ihn zu verschieben. Drücken Sie , um ihn auf die andere
Seite zu drehen; er erscheint nun gespiegelt und seine Pads haben sich von rot in blau geändert.

M F
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Alle Leiterplattenlagen werden von der Vorderseite der Leiterplatte aus betrachtet. Footprints auf der
Unterseite der Leiterplatte stehen daher auf dem Kopf und erscheinen gespiegelt.

Jede Leiterplattenlage hat eine eigene Farbe, die durch die Farbfelder auf der Registerkarte „Lagen“ im

Bedienfeld „Darstellung“ angezeigt wird. Im Standard-Farbschema sind die Elemente auf der Ebene „F.Cu“
(Vorderseitige Kupferlage) rot, während die Elemente auf der Ebene „B.Cu“ (Rückseitige Kupferlage) blau
sind.

Platzieren Sie nun die beiden anderen Komponenten. Wählen Sie nacheinander jedes Bauteil aus und

verschieben und drehen Sie es dann mit  und . Achten Sie auf die Rattennest-Linien zwischen den
einzelnen Pads, um die einfachste Anordnung der Komponenten zu wählen; bei einer guten Anordnung sind
die Linien wenig bis gar nicht überkreuzt. Eine mögliche Anordnung zeigt der folgende Screenshot.

M R
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Leiterbahnen routen
With the components in place, it’s time to connect the pads with copper tracks.

The first track will be drawn on the front of the board, so change the active layer to F.Cu  in the Layers tab

of the Appearance panel.

Click Route Tracks  in the right-hand toolbar or press . Click on the led  pad of D1  and release the

mouse button. The ratsnest line indicates there is an unrouted connection to the led  pad of R1 , so click on
that pad to draw a track connecting the two pads. Clicking on the second pad completes the track. The
ratsnest line between the led  pins is no longer drawn because the connection has been made in copper.

X
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Now draw a track between the GND  pads of BT1  and D1 , starting with the BT1  pad on the back of the
board. Notice that the active layer automatically changed to B.Cu  after clicking on the BT1  pad. Click on the
D1  pad to finish the track.

While BT1  has surface mount pads that are only on the bottom of the board, D1  has through hole pads that
can connect to tracks on both the front and back. Through hole pads are one way to make a connection
between multiple layers. In this case, D1  is a component on the front side of the board, but its through hole
pads are used to connect to a track on the back of the board.

Eine andere Möglichkeit, eine Verbindung zwischen den Lagen herzustellen, ist die Verwendung eines Vias.
Beginnen Sie das Routing am VCC  Pad von BT1  auf der Rückseite der Platine. Drücken Sie  und klicken
Sie auf halber Strecke zwischen BT1  und R1 , um ein Via einzufügen, das auch die aktive Ebene auf F.Cu
umschaltet. Vervollständigen Sie die Leiterbahn auf der Oberseite der Platine, indem Sie auf das VCC -Pad

von R1  klicken.

V
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Zu diesem Zeitpunkt sind alle Verbindungen geroutet. Dies kann durch einen Blick auf den Statusbildschirm
unten links im Fenster überprüft werden, wo die Anzahl der nicht gerouteten Netze mit 0 angegeben ist.

Platzierung von Kupferzonen
Copper zones are regions of copper with an associated net. Zones automatically connect to copper objects

belonging to the same net and avoid objects belonging to other nets. Zones are often used for ground and
power connections because they provide a lower impedance connection than tracks.

Fügen Sie eine GND -Zone auf der Unterseite der Platine hinzu, indem Sie auf die unterste Kupferebene

wechseln und in der rechten Werkzeugleiste auf die Schaltfläche Gefüllte Zone hinzufügen  klicken.

Klicken Sie auf die Platine, um die erste Ecke der Zone zu platzieren.

Wählen Sie im Dialogfeld Kupferzonen-Eigenschaften  das Netz GND  und stellen Sie sicher, dass die Ebene
B.Cu  ausgewählt ist. Klicken Sie auf OK und dann auf die anderen drei Ecken der Zone. Doppelklicken Sie
beim Platzieren der letzten Ecke, um die Zone zu vervollständigen.
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The zone outline is displayed on the canvas, but the zone is not yet filled — there is no copper in the zone
area, and therefore the zone is not making any electrical connections. Fill the zone with Edit → Fill All
Zones ( ). Copper has been added to the zone, but it doesn’t connect to the VCC  or led  pads and tracks,
and is clipped by the board edge. It overlaps with the GND  track drawn earlier, and it connects to the GND

pads through thin tracks. These are thermal reliefs, which make the pads easier to solder. Thermal reliefs
and other zone settings can be modified in the zone properties dialog.

B
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In KiCad werden Zonen nicht automatisch gefüllt, wenn sie zum ersten Mal gezeichnet oder geändert
werden, oder wenn Footprints innerhalb der Zonen verschoben werden. Zonen werden durch manuelles
Füllen gefüllt und wenn Sie den DRC ausführen. Stellen Sie sicher, dass die Zonenfüllungen auf dem neuesten
Stand sind, bevor Sie Fertigungsdaten erzeugen.

Manchmal können gefüllte Zonen die Sicht auf andere Objekte in einem vollen Layout erschweren. Zonen

können mit Ausnahme ihrer Umrisse über die Schaltfläche Zonenkonturen zeichnen  in der linken

Symbolleiste ausgeblendet werden. Zonen behalten ihren gefüllten Status, auch wenn nur ihre Umrisse
angezeigt werden - das Ausblenden einer Zonenfüllung ist nicht zu verwechseln mit deren Aufhebung.

Zonen können auch mittels des Darstellungsbedienfelds transparent gemacht werden, und inaktive Ebenen
können auch mittels der Lagen-Anzeigeoptionen im Bedienfeld Darstellung  ausgeblendet oder gedimmt
werden.

Design Regel Check
Design Rule Checking is the layout equivalent of Electrical Rule Checking for the schematic. DRC looks for

design mistakes like mismatches between the schematic and layout, copper regions that have insufficient
clearance or are shorted together, and tracks that do not connect to anything. You can also write custom DRC
rules. To view the full list of design rules that are checked and to adjust their severity, go to File → Board
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Setup…  → Design Rules → Violation Severity. Running DRC and fixing all errors is strongly advised before
generating fabrication outputs.

Führen Sie einen DRC mit Inspektion → Designregeln überprüfen (DRC) aus, oder verwenden Sie die
Schaltfläche  in der oberen Symbolleiste. Klicken Sie auf DRC starten. Wenn die Prüfung abgeschlossen

ist, sollten keine Fehler oder Warnungen angezeigt werden. Schließen Sie das DRC-Fenster.

Now intentionally cause a DRC error by moving the resistor footprint to overlap the filled area of the zone.
Use  (Drag) to move the resistor footprint slightly while keeping the tracks attached to its pads. This

creates a clearance violation because the VCC  and led  pads of the resistor are shorted to the GND  zone fill.
Ordinarily this would be fixed by refilling the zone, but don’t refill the zone yet.

Run DRC again, but make sure to uncheck the Refill all zones before performing DRC checkbox. DRC
reports 6 violations: for each pad of R1 , there is a clearance violation between the pad and the zone,
another clearance violation between the pad’s through hole and the zone, and a third violation where the
pad’s solder mask opening exposes the copper of two different nets (the GND  fill and the track connected to

the pad). Arrows point to each violation in the canvas. Clicking on each violation message zooms in on the
respective violation.

D
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Schließen Sie den DRC-Dialog, drücken Sie , um die Zone neu zu füllen, und führen Sie den DRC erneut aus.
Alternativ können Sie auch das Kontrollkästchen Alle Zonen ausfüllen vor dem DRC aktivieren und den
DRC erneut ausführen. Alle Verletzungen werden behoben.

3D-Betrachter
KiCad bietet einen 3D-Betrachter, der für die Inspektion der Leiterplatte nützlich ist. Öffnen Sie den 3D-

Betrachter mit Ansicht → 3D Betrachter. Schwenken Sie durch Ziehen mit der mittleren Maustaste, und
drehen Sie durch Ziehen mit der linken Maustaste. Drehen Sie die Leiterplatte, um die LED und den
Widerstand auf der Oberseite und den Batteriehalter auf der Unterseite zu sehen.

Es steht ein Raytracing-Modus zur Verfügung, der zwar langsamer ist, aber ein genaueres Rendering bietet.

Wechseln Sie zum Raytracing-Modus mit Einstellungen → Raytracing.

B
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Viele der Footprints in der KiCad-Bibliothek werden mit 3D-Modellen geliefert, einschließlich aller

Footprints, die in dieser Anleitung verwendet werden. Einige Footprints werden nicht mit 3D-Modellen
geliefert, aber Benutzer können ihre eigenen hinzufügen.

Fertigungsdaten
Wenn das Design der Leiterplatte fertig ist, besteht der letzte Schritt darin, die Fertigungsdaten zu
generieren, damit die Leiterplatte hergestellt werden kann.

Öffnen Sie den Plot-Dialog mit Datei → Plotten… . Dieser Dialog kann das Design in verschiedenen Formaten
plotten, aber Gerber ist normalerweise das richtige Format für die Bestellung bei einem PCB-Hersteller.

Geben Sie ein Ausgabeverzeichnis an, damit die geplotteten Dateien in einem Ordner gesammelt werden.
Andernfalls sind die Standardeinstellungen in Ordnung, aber stellen Sie sicher, dass alle notwendigen

Ebenen markiert sind: die Kupferlagen ( *.Cu ), die Leiterplattenkontur ( Edge.Cuts ), die Lötstoppmaske
( *.Mask ) und der Siebdruck ( *.Silkscreen ). Die Pastenschichten ( *.Paste ) sind für die Herstellung von
Lotpastenschablonen nützlich. Die Klebelagen ( *.Adhesive ) werden nur benötigt, wenn Bauteile während
der Bestückung auf die Platine geklebt werden sollen. Andere Schichten können zum Plotten nützlich sein,

sind aber in der Regel für die Herstellung von Leiterplatten nicht erforderlich.



36

Klicken Sie auf Plotten, um die Gerberdateien zu erzeugen. Klicken Sie auch auf Bohrdateien erzeugen… 
und dann auf Bohrdatei generieren, um Dateien zu erstellen, die die Position aller Löcher angeben, die in
die Platine gebohrt werden sollen. Schließen Sie abschließend den Plot-Dialog. Der Entwurf ist damit
abgeschlossen.



37
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Tutorial Teil 4: Benutzerdefinierte Symbole
und Footprints
Die Schaltung ließe sich durch Hinzufügen eines Schalters zum Ein- und Ausschalten der LED verbessern. Um
diesen Schalter hinzuzufügen, muss eine neue Symbol- und Footprint-Bibliothek erstellt, ein Schaltersymbol

gezeichnet und ein Footprint für den Schalter erstellt werden.

Der spezielle Schalter, der in dieser Anleitung verwendet wird, ist der NKK M2011S3A1W03, ein SPST-
Kippschalter. Es können auch viele andere Schalter verwendet werden, aber die Pin-Nummerierung und die

Abmessungen des Footprints müssen möglicherweise angepasst werden.

Grundlagen der Bibliothek und der Bibliothekstabelle
Symbole und Footprints sind in Bibliotheken organisiert. Eine Bibliothek kann Symbole oder Footprints
enthalten, aber nicht beides.

KiCad speichert die Symbol- und Footprint-Bibliotheken des Benutzers in der Symbol-Bibliothekstabelle

bzw. Footprint-Bibliothekstabelle. Jede Bibliothekstabelle besteht aus einer Liste von Bibliotheksnamen
und dem Ort, an dem sich die jeweilige Bibliothek auf der Festplatte befindet.

Zusätzlich zu den globalen Bibliothekstabellen für Symbole und Footprints gibt es auch projektspezifische
Bibliothekstabellen für Symbole und Footprints. Symbole und Footprints, die zu den globalen Tabellen

hinzugefügt werden, sind in allen Projekten verfügbar, während Symbole und Footprints in den
projektspezifischen Tabellen nur für das jeweilige Projekt verfügbar sind. Benutzer können ihre eigenen
Bibliotheken zu den globalen Bibliothekstabellen oder zu den projektspezifischen Tabellen hinzufügen.

Die Symbolbibliothekstabellen können mit Einstellungen → Symbolbibliotheken verwalten…  in den

Fenstern des Schaltplaneditors oder des Symboleditors angezeigt oder bearbeitet werden. Die
Bibliothekstabellen für die Footprints können mit Einstellungen → Footprintbibliotheken verwalten…  im
Platineneditor oder im Footprint-Editor angezeigt oder bearbeitet werden. Auf beide Bibliothekstabellen
kann auch über den Projektmanager zugegriffen werden.

https://www.nkkswitches.com/pdf/MtogglesBushing.pdf
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Häufig werden Pfade zu Bibliotheken mit Pfadsubstitutionsvariablen definiert. Auf diese Weise kann ein
Benutzer alle seine Bibliotheken an einen neuen Ort verschieben, ohne die Bibliothekstabellen zu ändern.

Das Einzige, was geändert werden muss, ist die Definition der Variable, um auf den neuen Ort zu verweisen.
Die Pfadsubstitutionsvariablen werden mit Einstellungen → Pfade konfigurieren…  im Projektmanager
oder in einem der Editorfenster bearbeitet.

Eine nützliche Variable zur Pfadsubstitution ist ${KIPRJMOD} . Diese Variable zeigt immer auf das aktuelle

Projektverzeichnis, so dass sie zum Einbinden von projektspezifischen Bibliotheken verwendet werden
kann, die innerhalb des Projektverzeichnisses gespeichert sind.

Beim ersten Start fordert KiCad den Benutzer auf, die Symbol-Bibliothekstabelle und die Footprint-
Bibliothekstabelle einzurichten. Um diese Einrichtung erneut zu durchlaufen, löschen Sie die Dateien der

Bibliothekstabellen für Symbole und Footprints oder benennen Sie sie um. Erstellen Sie eine
Sicherungskopie der Tabellen, bevor Sie sie löschen.

Der Speicherort der Dateien für die Symbol- und Footprint-Bibliothekstabellen hängt vom Betriebssystem
ab.

Windows: %APPDATA%\kicad\9.0\sym-lib-table  and %APPDATA%\kicad\9.0\fp-lib-table

Linux: ~/.config/kicad/9.0/sym-lib-table  and ~/.config/kicad/9.0/fp-lib-table

macOS: ~/Library/Preferences/kicad/9.0/sym-lib-table  and

~/Library/Preferences/kicad/9.0/fp-lib-table

Neue Globale oder Projektspezifische Bibliotheken erstellen
Zum Zeichnen eines neuen Symbols oder Footprints wird zuerst eine Bibliothek gewählt, in der es
gespeichert werden soll. In dieser Anleitung werden das Schaltersymbol und der Footprint in neuen
projektspezifischen Bibliotheken gespeichert.

Öffnen Sie den Symboleditor im Projektmanager. Klicken Sie auf Datei → Neue Bibliothek, und wählen Sie

Projekt. Wählen Sie einen Namen für die neue Bibliothek (z.B. „Erstes_Projekt.kicad_sym“) und speichern
Sie sie im Projektverzeichnis. Die leere neue Bibliothek ist nun im Bibliotheksfenster links ausgewählt und
wurde automatisch zur Projekt-Bibliothekstabelle hinzugefügt Überprüfen Sie die Registerkarte
Projektspezifische Bibliotheken in Einstellungen → Symbolbibliotheken verwalten… .

Neue Symbole erstellen
Erstellen Sie nun das Schaltersymbol in der neuen Bibliothek. Wenn die Bibliothek Erstes_Projekt  im
Bibliotheksfenster ausgewählt ist, klicken Sie auf Datei → Neues Symbol… . Geben Sie in das Feld
Symbolname die Teilenummer ein: „M2011S3A1W03“. Schaltersymbole sollten Referenzbezeichner haben,
die mit „SW“ beginnen, ändern Sie also das Feld Standard-Referenzbezeichner in „SW“. Alle anderen

Felder können als Standardwerte beibehalten werden.

In der Bibliotheksübersicht wird das Symbol „M2011S3A1W03“ jetzt unter der Bibliothek „Erstes_Projekt“
angezeigt. In der Zeichenebene zeigt ein Kreuz die Mitte des Footprints an, und es wurde Text für den

Referenzbezeichner hinzugefügt. Verschieben Sie den Text zunächst von der Mitte des Symbols weg, um ihn
aus dem Weg zu räumen.
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Symbol-Pins
Start drawing the symbol by adding a pin. This symbol will not have a pin 1, so we will start with a pin
numbered 2. Click the Add a pin button  on the right toolbar. The Pin Properties dialog will appear. Set

the pin properties as follows:

Pin name: A

Pin number: 2

Electrical type: Passive

Orientation: Right

X Position: -200 mils

Y Position: 0

Click OK, then click on the canvas to place the pin. If the pin moved after clicking OK, it might be necessary

to edit the pin’s properties again (double click the pin, or right click on the pin → Properties… ) to set the
position correctly.

NOTE

Es ist dringend zu empfehlen, im Schaltplan-Editor und im Symbol-Editor immer mils
(oder Zoll) zu verwenden, insbesondere für Symbolpins. Die Vermischung von imperialen
und metrischen Einheiten führt zu Symbolpins, die nicht richtig angeschlossen werden
können, weil sie nicht mit Verbindungen oder anderen Pins ausgerichtet sind. Die KiCad-
Bibliotheken verwenden ein 50-mil-Raster für ihre Pins; die Verwendung eines anderen
Einheitensystems verhindert, dass Ihre Symbole und Schaltpläne mit den vorinstallierten
Symbolen von KiCad verbunden werden können. Beachten Sie, dass Einheiten im
Schaltplan, anders als im Leiterplatteneditor, keine physikalische Bedeutung haben.
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Fügen Sie einen zweiten Pin hinzu, aber verwenden Sie dieses Mal nicht das Werkzeug Pin hinzufügen.
Drücken Sie stattdessen . Ein neuer Pin mit der Nummer 3 wird dem Symbol hinzugefügt, direkt unter
Pin 2.

TIP

An vielen Stellen in KiCad wird durch Drücken von  die letzte Aktion wiederholt.
Die Position des neuen Elements wird verschoben und die Nummerierung automatisch
erhöht, falls zutreffend. Im Symboleditor kann dies verwendet werden, um schnell eine
große Anzahl von Pins zu platzieren. Im Schaltplaneditor können Sie damit ein Bauteil
wiederholt platzieren oder die Pins eines großen Bauteils mit nummerierten
Beschriftungen versehen.  kann auch im Footprint- und Platineneditor nützlich sein.

We want Pin 3 to be on the right side of the switch symbol, so we will edit its properties to change the
location and orientation. Instead of using the Pin Properties dialog, this time we can use the Properties
Panel. This is a docked panel on the left side of the editing canvas that lets you view and edit the properties

of the selected object or objects. To show or hide the Properties Panel, use the  button in the left toolbar.

With pin 3 selected, use the Properties panel to set its properties as follows:

Pin Name: B

Position X: 200 mils

Position Y: 0

Orientation: Left

Einfg

Einfg

Einfg
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NOTE The Properties Panel is available in every KiCad editor (Schematic, Board, Symbol, and
Footprint).

Grafische Funktionen
Nachdem Sie die Pins platziert haben, verwenden Sie die Werkzeuge Kreis  und Linie , damit das

Symbol wie ein SPST-Schalter aussieht. Für diesen Schritt ist es nützlich, zu einem feineren Raster zu

wechseln: Klicken Sie mit der rechten Maustaste auf die Zeichenfläche und wählen Sie im Untermenü Raster
ein kleineres Raster. Nachdem Sie die grafischen Formen hinzugefügt haben, wechseln Sie wieder zu einem
50 mil-Raster.

WARNING
Kleine Raster sind für grafische Funktionen nützlich, aber Symbolpins müssen immer
auf einem 50 mil (1,27 mm) Raster platziert werden. Pins, die nicht an einem 50 mil-
Raster ausgerichtet sind, können nicht mit Leitungen im Schaltplan verbunden werden.

Symboleigenschaften
Bearbeiten Sie nun die Eigenschaften des gesamten Symbols mit Datei → Symboleigenschaften, oder durch
Doppelklick auf die Zeichenfläche. Ändern Sie das Feld Wert in M2011S3A1W03 , und fügen Sie SPST-

Kippschalter  zum Feld Schlüsselwort hinzu, um das Auffinden des Symbols durch Suchen zu erleichtern.
Für dieses Symbol liefern die Pin-Namen keine nützlichen Informationen. Deaktivieren Sie daher Pinnamen
anzeigen, um das Symbol optisch zu vereinfachen.

Nachdem Sie auf OK geklickt haben, verschieben Sie den Text des Wertefeldes nach unten, so dass er sich
nicht mit der Symbolgrafik überschneidet.
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Das Symbol ist nun vollständig. Speichern Sie es und fahren Sie mit der Erstellung eines Footprints fort.

Erstellen neuer Footprints
Open the Footprint Editor and create a new project-specific footprint library named getting-

started.pretty  (File → New Library… ). As with symbol libraries, the new footprint library is added to the
project library table. With the new library selected in the Libraries pane, create a new footprint (File → New
Footprint… ). Edit the footprint’s properties (  button in the top toolbar) and set the following

properties:

Footprint name: Switch_Toggle_SPST_NKK_M2011S3A1x03

Value: Switch_Toggle_SPST_NKK_M2011S3A1x03

Component type: Through hole

Footprint Pads
The switch has two pins, numbered in the datasheet as 2 and 3, and spaced 4.7 mm apart. For ease of

placement, adjust the grid to match the pad spacing. Open the grid settings by right-clicking the  button

in the left toolbar and selecting Edit Grids… . Add a new grid with the plus button at the bottom. Set the new

grid’s X size to 4.7 mm . Accept the dialog, go back to the editing canvas, and then switch to the new grid in
the grid dropdown in the top toolbar, if it is not already selected.

By convention, through-hole footprints have pin 1 located at (0,0)  and are oriented with pin 1 in the top
left. The SPST version of this switch does not have pin 1, so the footprint will leave (0,0)  empty and place

pads 2 and 3 at (0, 4.7 mm)  and (0, 9.4 mm) . Note that in KiCad’s default coordinate system, the positive Y-
axis is oriented downwards.

NOTE
The X and Y coordinates of the cursor are displayed in the status bar at the bottom of the
window. You can use this to check the coordinates when you are drawing or placing
something.
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Verwenden Sie das Werkzeug Pad hinzufügen  in der rechten Symbolleiste, um ein Pad eine

Rasterteilung unter dem Ursprung zu platzieren, also (0, 4,7 mm). Drücken Sie , um das Pad-Werkzeug
zu verlassen, und doppelklicken Sie dann auf das Pad, um seine Eigenschaften zu bearbeiten. Ändern Sie die

Pad-Nummer auf 2  und überprüfen Sie, ob die Position korrekt ist. Die Schalterstifte sind 1,17 mm x 0,8 mm
groß, was eine Diagonale (maximale Pin-Abmessung) von 1,42 mm ergibt. Setzen Sie daher den
Lochdurchmesser auf 1,42 mm + 0,2 mm = 1,62 mm  und den Paddurchmesser auf 1,62 mm + 2*0,15 mm =
1,92 mm , um einen angemessenen Restring zu erhalten.

Now use the Add a pad tool again to place the other pad at (0, 9.4 mm) . Notice that the pad number is

automatically incremented and the properties including pad size and hole size are copied from the previous
pad.

Wenn beide Pads platziert sind, sehen die Restringe etwas klein aus. Der Schalter wird leichter zu löten und

mechanisch robuster sein, wenn die Restringe größer sind. Erhöhen Sie die Dicke des Ringes von 0,15 mm
auf 0,3 mm, indem Sie Pad 2 bearbeiten und die Padgröße auf 1,62 mm + 2*0,3 mm = 2,22 mm  ändern. Ändern
Sie nicht die Lochgröße. Beachten Sie, dass das Feld Padgröße  mathematische Ausdrücke akzeptiert, so dass
1,62+2*0,3  direkt eingegeben werden kann und zu 2,22 mm führt.

TIP Viele Textfelder in KiCad unterstützen mathematische Ausdrücke, einschließlich
Einheitenumrechnungen.

Führen Sie die gleiche Änderung des Restringes auch für das andere Pad durch. Klicken Sie mit der rechten
Maustaste auf Pad 2, klicken Sie auf Pad-Eigenschaften auf andere Pads übertragen…  und dann auf

Esc
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Ändere Pads im aktuellem Footprint.

Footprint-Grafik
Ein guter Footprint hat den exakten Umriss des Teils auf der Fertigungsebene ( F.Fab ), einen etwas
größeren Umriss auf der Siebdruckebene ( F.Silkscreen ) und eine Abstandsfläche ( F.Courtyard ), die den

gesamten Footprint umgibt, um Überlappungen mit anderen Footprints zu vermeiden.

Switch to the front fabrication layer by clicking F.Fab in the Layers panel at right. The fabrication outline
should precisely match the physical dimensions of the part, which is 7.9 mm wide and 13 mm tall. Use the line

, rectangle , or polygon  tools to draw the outline of the part as shown in the screenshot below.

One way to precisely place the outline is to create a new grid with the correct X and Y spacing, as we did for
the pads. Make sure to uncheck the Linked checkbox in the Grid Settings dialog to allow unequal X and Y

grid spacing. You can then adjust the grid origin by right clicking the  button and selecting Grid Origin… .

Configure the grid spacing and origin as follows:

X grid: 7.9 mm

Y grid: 13 mm

X origin: 7.9 mm / 2 = 3.95 mm

Y origin: 4.7 mm - (13 mm / 2) = -1.8 mm .

The completed fabrication drawing is shown below, with corner coordinates annotated.

Next, switch to the F.Silkscreen  layer. We want the silkscreen outline to be just outside of the part outline,
so the silkscreen lines will be drawn 0.11 mm to the outside of the lines on the fabrication layer (0.11 mm is

half of the 0.10 mm fab line width, plus half of the 0.12 mm silkscreen line width). The exact coordinates are
shown in the screenshot below, and helpful grid settings are:

X-Raster: 7.9 mm + 2 * 0.11 mm = 8.12 mm

Y-Raster: 13 mm + 2 * 0.11 mm = 13.22 mm
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X-Ursprung: 8.12 mm / 2 = 4.06 mm

Y-Ursprung: -1.8 mm - 0.11 mm = -1.91 mm

Finally, select the F.Courtyard  layer. We want the courtyard outline to surround the part with a 0.25 mm
clearance.

For variety, we can use a different strategy to draw the shape on this layer. Switch to a 1mm grid instead of a
custom grid, and draw a rectangle roughly surrounding the footprint. Select the rectangle and press  to
edit its properties, and enter the corner coordinates of the rectangle directly. The corner coordinates are:

Top left: (-4.2, -2.05)

Bottom right: (4.2, 11.45)

E
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Nachdem Sie die Umrisse fertiggestellt haben, positionieren Sie den Text wie unten gezeigt. Der Footprint ist
fertig.

Konventionen der KiCad-Bibliothek
Um qualitativ hochwertige Symbol- und Footprint-Bibliotheken zu verwalten, hat KiCad ein KiCad Library
Conventions Dokument, das eine Reihe von Richtlinien für Symbole und Footprints enthält. Es ist nicht
notwendig, diese Konventionen für persönliche Bibliotheken zu erfüllen, aber sie sind ein guter

Ausgangspunkt. Footprints und Symbole in der offiziellen Bibliothek müssen KLC folgen. KLC wird als
Grundlage für die Symbole und Footprints in diesem Handbuch verwendet.

Schalter zum Schaltplan hinzufügen
Da der Footprint nun vollständig ist, kann das Schaltersymbol so angepasst werden, dass hierfür
standardmäßig der richtige Footprint verwendet wird.

Gehen Sie zurück zum Symboleditor und öffnen Sie das Schaltersymbol. Bearbeiten Sie die
Symboleigenschaften. Klicken Sie in das Feld Footprint  und dann auf das Bibliothekssymbol , das nun
erscheint. Navigieren Sie zur Footprint-Bibliothek des Projekts und doppelklicken Sie auf den Footprint des
Schalters. Speichern Sie das Symbol.

Der Footprint des Schalters wird diesem Symbol nun standardmäßig zugewiesen. Der Footprint muss nicht
jedes Mal manuell ausgewählt werden, wenn das Symbol zu einem Schaltplan hinzugefügt wird.

https://klc.kicad.org/
https://gitlab.com/kicad/libraries
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Öffnen Sie den Schaltplan, fügen Sie ein neues Symbol hinzu, und wählen Sie das neue Schaltersymbol aus.
Verdrahten Sie es, um die LED und die Batterie zu verbinden oder zu trennen.

Es ist nicht notwendig, manuell einen Footprint für den Schalter zu wählen, da das Schaltersymbol bereits
einen Footprint vorgibt. Führen Sie den ERC aus, um sicherzustellen, dass der geänderte Schaltplan nicht
gegen elektrische Regeln verstößt.

Schalter zum Layout hinzufügen
Make sure the schematic is saved, then open the Board Editor to add the symbol to the layout. Update the
PCB with the schematic changes using Tools → Update PCB from Schematic…  and place the switch
footprint onto the board as shown. If needed, resize the board outline and copper zone (the copper zone

will unfill if it is resized, but you can re-fill it as necessary with ).B
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Das Rattennest zeigt die neuen Verbindungen, die verlegt werden müssen. Außerdem muss die Verbindung
zwischen der Batterie und dem Widerstand entfernt werden.

First, delete the unneeded tracks. Select one of the tracks between the battery and the resistor — it doesn’t
matter which. Press  several times to expand the selection to include all the segments between the
battery and resistor. Press  to remove the connection.

Route the new tracks between the battery and the switch, and between the switch and the resistor. Press 

to refill the zones.

Führen Sie abschließend den DRC erneut aus, um sicherzustellen, dass die modifizierte Platine keine
Designregeln verletzt.

U

Delete

B
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Verknüpfung von Symbolen, Footprints und 3D-Modellen

Symbole und Footprints
Wie im Abschnitt Footprint Zuordnung beschrieben, muss jedem Symbol im Schaltplan bei der
Schaltplanerstellung ein Footprint zugewiesen werden. Der Name des Footprints, der jedem Symbol

zugewiesen wurde, wird im Feld Footprint  in den Eigenschaften des Symbols gespeichert.

Symbole können einen vorgewählten Footprint aufweisen. Footprints müssen solchen Symbolen nicht

manuell zugewiesen werden, da ein Footprint bei der Erstellung des Symbols ausgewählt wurde. Benutzer
können den vorgewählten Footprint während des Footprint-Zuweisungsprozesses wie gewohnt
überschreiben. Die Definition eines Standard-Footprints ist ratsam für Symbole, denen in der Regel oder

immer derselbe Footprint zugewiesen wird, z.B. ein Bauteil, das nur in einem Paket verfügbar ist. Der
Footprint des Schalters wurde als Standard für sein zugehöriges Symbol festgelegt.
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Symbole können auch Footprint-Filter angeben, mit denen Footprints ausgeblendet werden können, die
nicht mit dem Symbol kompatibel sind. Das Symbol „74HC00“ verfügt beispielsweise über Footprint-Filter,

mit denen nur die zutreffenden DIP- und SO14-Footprints im Werkzeug Footprints zuweisen angezeigt
werden.

Die KLC-Anforderungen für Footprint-Filter enthalten einige nützliche Tipps für effektive Footprint-Filter.

Footprints und 3D Modelle
3D-Modelle für Komponenten werden in separaten Dateien gespeichert. Die Dateinamen für die 3D-Modelle
der Komponenten werden im Footprint gespeichert. Zu jedem Footprint kann eine beliebige Anzahl von 3D-

Modellen hinzugefügt werden. Die Dateinamen der 3D-Modelle sowie die Modellskalierung, die Drehung, der
Versatz und die Deckkraft werden auf der Registerkarte 3D-Modelle der Footprint-Eigenschaften festgelegt.

https://klc.kicad.org/symbol/s5/s5.2/
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Es werden sowohl STEP- ( .step ) als auch VRML- ( .wrl ) 3D-Modellformate unterstützt. STEP-Dateien sind
nützlich, wenn Maßgenauigkeit erforderlich ist, während VRML-Dateien für visuell attraktivere Renderings

verwendet werden können. Viele Footprints in der KiCad-Bibliothek haben zugehörige 3D-Modelle; diese
Modelle werden sowohl im VRML- als auch im STEP-Format bereitgestellt. Nur eines der beiden Modelle
muss im Footprint aufgeführt werden (normalerweise wird der VRML-Dateiname angegeben). KiCad kann
automatisch die STEP-Version ersetzen, wenn ein 3D-Modell der Platine für mechanische CAD-Zwecke

exportiert wird.

NOTE

Nicht alle Footprints in der KiCad-Bibliothek sind mit 3D-Modellen versehen, aber alle
Footprints führen einen 3D-Modell-Dateinamen auf, selbst wenn das 3D-Modell nicht
existiert. Auf diese Weise können 3D-Modelle zu einem späteren Zeitpunkt hinzugefügt
werden, ohne dass der Footprint bearbeitet werden muss.

FreeCAD zusammen mit der StepUp Workbench sind nützlich für die Erstellung von 3D-

Komponentenmodellen. Sie werden für viele der Modelle in der KiCad-Bibliothek verwendet. StepUp wird
verwendet, um STEP- und VRML-Dateien mit korrekter Platzierung, Skalierung und Drehung zu erzeugen.

https://www.freecadweb.org/
https://github.com/easyw/kicadStepUpMod/
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Das weitere Vorgehen
Weitere Lernhilfen
Weitere Informationen über die Verwendung von KiCad finden Sie im Handbuch.

Weitere Ressourcen sind das offizielles KiCad-Benutzerforum, Discord oder IRC und zusätzliche
Lernressourcen der KiCad-Community.

Um mehr darüber zu erfahren, was KiCad ermöglicht, besuchen Sie den Abschnitt Made With KiCad auf der

Website, oder öffnen Sie die in KiCad enthaltenen Demoprojekte (Datei → Demoprojekt öffnen… ).

Helfen Sie KiCad zu verbessern
Um einen Fehler zu melden oder eine Funktion zu beantragen, benutzen Sie bitte Hilfe → Fehler melden
oder öffnen Sie ein Problem auf Gitlab.

Um zur Entwicklung von KiCad beizutragen, besuchen Sie bitte die Developer Contribution page. Benutzer

können auch helfen, indem sie einen Beitrag zu Bibliotheken oder zur Dokumentation und Übersetzung
leisten. Und schließlich können Sie die weitere Entwicklung von KiCad finanziell unterstützen.

https://docs.kicad.org/
https://forum.kicad.info/
https://www.kicad.org/community/chat/
https://www.kicad.org/help/learning-resources/
https://www.kicad.org/made-with-kicad/
https://gitlab.com/kicad/code/kicad/-/issues
https://dev-docs.kicad.org/en/contribute/
https://www.kicad.org/libraries/contribute/
https://www.kicad.org/contribute/docs-team/
https://www.kicad.org/donate/faq/
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